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It is my great pleasure to welcome members and researchers of the United States Department of Energy to Pittsburgh! We are
thrilled to host your event, Addressing the Nation's Energy Needs Through Technology Innovation.

Dear Friends:

Once known for the production of glass, steel and iron, Pittsburgh is now a hub for its advances in technology and robotics,
healthcare, medical, education, green buildings, tourism, and of course, energy — and we're not done yet.

In addition, Pittsburgh has a thriving and widely renowned arts and culture scene and a booming culinary experience, and the
city is consistently named one of the most livable and best travel destinations in the U.S.

As you explore the city, | am sure you will enjoy our only-in-Pittsburgh attractions that pay homage to the past, celebrate the
present and give a sneak peek at the future.

Our Cultural District is home to seven world-class theaters, and our 90 neighborhoods, spread over a diverse landscape,
embrace a vibrant culture distinctive to this city.

| encourage you to discover the unique charm of Pittsburgh and kindness of our people.
Pittsburgh is a city on the rise, and we are excited to share it with you!
Best wishes for a wonderful conference and enjoy your time in our city.

Sincerely,

C ' "'t Fifth Avenue Place

120 Fifth Avenue, Suite 2800
Pittsburgh, PA 15222-3099
412.281.7711; 800.359.0758
412.644.5512 fax
Craig T. Davis, CDME
President and CEO visitpittsburgh.com

Presentations
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BRIAN J. ANDERSON
DIRECTOR, NATIONAL ENERGY TECHNOLOGY LABORATORY

Welcome to Pittsburgh!

On behalf of the National Energy Technology Laboratory (NETL), | would like to personally welcome you to the
City of Pittsburgh and the 2019 Carbon Capture, Utilization, Storage, and Oil & Gas Technologies Integrated
Review Meeting. | appreciate you taking the time to visit our city and participate in this five-day event designed
to explore the exciting and cutting-edge research being conducted by NETL and our many talented research
partners.

The City of Pittsburgh has a long history of developing groundbreaking technologies that have had a dramatic
impact on our world, such as the first commercial radio station, the first retractable domed roof and our nation's
first commercial nuclear reactor. Today, Pittsburgh continues to host and foster unparalleled collaborations with
research and technology partners across diverse sectors to drive innovation. These innovations will forge a
resilient and sustainable future and ensure regional and global energy security and prosperity.

NETL shares this same innovative vision, driving our mission to discover, integrate and mature technology
solutions to enhance the nation’s energy foundation and protect the environment for future generations. For
more than 100 years, NETL has developed tools and processes to provide clean, reliable and affordable energy
to the American people.

The 2019 Carbon Capture, Utilization, Storage, and Oil & Gas Technologies Integrated Review Meeting brings
together some of the best research talent in the country who are working to solve some of our greatest
energy-related challenges. Over the next five days, researchers and scientists will highlight some of the most
advanced research currently underway. Each of these areas can and will be impactful, both domestically and
internationally.

We hope you enjoy this rare opportunity to share in the research efforts of these four combined programs in a
single interactive event. | invite you to explore our city while you are here and to enjoy the program we have put
together.

Once again, welcome to Pittsburgh and enjoy your visit!
Sincerely,

Brian J. Anderson, Ph.D.
Director
National Energy Technology Laboratory
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MONDAY

Meeting Registration/Continental Breakfast - Ballroom Foyer
Welcome/Introduction - Ballroom A

Steven Winberg, Assistant Secretary for Fossil Energy,
U.S. Department of Energy

Introduction
Brian Anderson, Director, National Energy Technology Laboratory

CCUS: Current Business Cases

e Anthony Armpriester, Director of Business Development,
NRG Energy

« Steve Whittaker, lllinois State Geological Survey

e Corwyn Bruce, International CCS Knowledge Centre

Break - Ballroom Foyer




MONDAY

10:30 AM

10:50 AM

11:10 AM

11:30 AM

11:50 AM

12:10 PM

12:30 PM

1:30 PM

1:50 PM

2:10 PM

2:30 PM

2:50 PM

3:10PM

3:30 PM

ROOM 406

CAPTURE - LAB/BENCH-SCALE RESEARCH

Moderator: Jose Figueroa, NETL

Bench-Scale Testing of Next-Generation Hollow-Fiber Membrane Modules (FE0026422)
 Shilu Fu, American Air Liquide Inc.

Energy-Efficient GO-PEEK Hybrid Membrane Process for Post-Combustion Carbon Dioxide Capture
(FE0026383)
 Shiguang Li, Gas Technology Institute

Novel Process That Achieves 10 MOL/KG Sorbent Swing Capacity in a Rapidly Cycled Pressure Swing
Adsorption Process (FE0026433)
e Ryan Lively, Georgia Institute of Technology

Cryogenic Carbon Capture Development (FE0028697)
« Larry Baxter, Sustainable Energy Solutions

Electrochemically Mediated Amine Regeneration in CO, Scrubbing Processes (FE0026489)
» T. Alan Hatton, Massachusetts Institute of Technology

Rapid Design and Testing of Novel Gas-Liquid Contacting Devices for Post-Combustion CO, Capture Via
3D Printing: Modular Adaptive Packing (FE0031530)
o Erik Meuleman, ION Engineering LLC

Lunch - Ballroom A

Moderator: Andrew Jones, NETL

Development and Bench-Scale Testing of a Novel Biphasic Solvent-Enabled Absorption Process for Post-
Combustion Carbon Capture (FE0031600)
» Yongqi Lu, University of lllinois at Urbana-Champaign

A Process with Decoupled Absorber Kinetics and Solvent Regeneration through Membrane Dewatering
and In-Column Heat Transfer (FE0031604)
» James Landon, University of Kentucky

Universal Solvent Viscosity Reduction Via Hydrogen Bonding Disruptors (FE0031629)
e Xu Zhou, Liquid lon Solutions LLC

ROTA-CAP: An Intensified Carbon Capture System Using Rotating Packed Beds (FE0031630)
o Osman Akpolat, Gas Technology Institute

Mixed Salt-Based Transformational Solvent Technology for CO, Capture (FE0031597)
 Palitha Jayaweera, SRI International

Development of Self-Assembly Isoporous Membranes (FEO031596)
» Hans Wijmans, Membrane Technology and Research Inc.

Break - Ballroom Foyer



MONDAY
SUBSURFACE PLENARY

BALLROOM B

Moderator: Bill Aljoe, NETL

10:30 AM Plains CO, Reduction Partnership and Phase IlI (FC26-05NT42592)
e Charles D. Gorecki, University of North Dakota Energy and Environmental Research Center

11:00 AM Big Sky Regional Carbon Sequestration Partnership - Phase Il (FC26-05NT42587)
o Lee Spangler, Montana State University, Energy Research Institute

11:30 AM EERC-DOE Joint Program on Research and Development for Fossil Energy-Related Resources; Subtask
3.1: Related Resources: Bakken-Rich Gas EOR Center (FE0024233)
« James Sorensen, University of North Dakota Energy and Environmental Research Center

12:00 PM First-Ever Field Pilot on Alaska's North Slope to Validate the Use of Polymer Floods for Heavy Oil
Enhanced Oil Recovery (FE0031606)
« Abhijit Dandekar, University of Alaska - Fairbanks; Reid Edwards, Hilcarp Alaska LLC

12:30 PM Lunch - Ballroom A

Moderator: Bill O'Dowd, NETL

1:30 PM North Dakota Integrated Carbon Storage Complex Feasibility Study (FE0029488)
» Wesley Peck, University of North Dakota Energy and Environmental Research Center

2:00 PM Integrated Midcontinent Stacked Carbon Storage Hub (FE0031623)
e Andrew Duguid, Battelle Memorial Institute

2:30 PM Commercial-Scale Carbon Storage Complex Feasibility Study at Dry Fork Station, Wyoming (FE0031624)
« Scott Quillinan, University of Wyoming

3:00 PM Developing and Validating Pressure Management and Plume Control Strategies in the Williston Basin
Through a Brine Extraction and Storage Test (FE0026160)
» John Hamling, University of North Dakota Energy and Environmental Research Center

3:30 PM Break - Ballroom Foyer

Oil & Gas Projects
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MONDAY

4:00 PM

4:20 PM

4:40 PM

5:00 PM

5:20 PM

5:40 PM

6:00 PM

ROOM 406

CAPTURE - LAB/BENCH-SCALE RESEARCH

Moderator: Andrew O'Palko, NETL

Bench-Scale Development of a Transformational Graphene Oxide-Based Membrane Process for Post-
Combustion CO, Capture (FE0031598)
» Shiguang Li, Gas Technology Institute

Flue Gas Aerosol Pretreatment Technologies to Minimize PCC Solvent Losses (FE0031592)
o Devin Bostick, Linde Gas North America LLC

Development of Carbon Molecular Sieves Hollow Fiber Membranes Based on Polybenzimidazole Doped
with Polyprotic Acids with Superior H,/CO, Separation Properties (FE0031636)
» Haiging Lin, University at Buffalo, SUNY

Emissions Mitigation Technology for Advanced Water-Lean Solvent-Based CO, Capture Processes
(FEO031660)
 Jak Tanthana, Research Triangle Institute

Syngas Purification Using High-Pressure CO,BOL Solvents with Pressure Swing Regeneration
(FWP-72564)
« Phillip Koech, Pacific Northwest National Laboratory (PNNL)

Adjourn Capture and Utilization Session

End of Day



4:00 PM

4:20 PM

4:40 PM

5:00 PM

5:20 PM

5:40 PM

6:00 PM

MONDAY

SUBSURFACE BREAKOUT

Moderator: Jerry Carr, NETL
Rooms 303, 304, 305

Task 5: Advances in Large-N Seismic
Measurements to Monitor Reservoir Behavior
(FWP-FEW0191)
 Eric Matzel, Lawrence Livermore National
Laboratory (LLNL)

Task 3: Assessment of Leakage Pathways
Using Joint EM-Seismic Borehole and Surface
Technologies

Task 4 Monitoring Technology for Deep CO,
Injection (FWP-ESD14095)
» Michael Wilt and Pierpaolo Marchesini, LBNL

Task 2: 2nd Generation SOV DAS
(FWP-ESD14095)
e Julia Correa, LBNL

Development of High Sensitivity Engineered
Optical Fiber for Distributed Acoustic Sensing
(FWP-FEW0246/FWP-FPO0007226)

* Michael Messerly, LLNL

Task 2: Monitoring for Small Leaks Over Large
Areas (FWP-FE-890-18-FY18)
e Youzuo Lin, LANL

National Risk Assessment Partnership Task 6:
Risk-Based Approach to Post-Injection Site
Closure

» Bob Dilmore, NETL

End of Day

Moderator: Bruce Brown, NETL
Rooms 301, 302

Numerical and Laboratory Investigations for
Maximization of Production From Tight/Shale Oil
Reservoirs (FWP-FPO0O0008115)
* George Moridis, Lawrence Berkeley National
Laboratory (LBNL)

Mechanistic Approach to Analyzing and Improving
Unconventional Hydrocarbon Production
(FWP-FE406-408-409)
e Hari S. Viswanathan, Los Alamos National
Laboratory (LANL)

Fundamental Chemical and Mechanical Processes
for Unconventional Formations (FWP-1022415)
o Ale Hakala, NETL

Basin-Specific Geochemistry to Improve
Unconventional Efficiency (FWP-100211)
« John Bargar, SLAC National Accelerator
Laboratory

Improved Understanding of Hydraulic Fracturing
Fluid Distribution in Unconventional Reservoir
Stimulation (FWP-FP0O0008256)

o Tetsu Tokunaga and Omotayo Omosebi, LBNL

Understanding and Controlling Sustainability of
Hydraulic Fracture Permeability in Ductile Shales
(FWP-FP0008114)

» Seiji Nakagawa, LBNL

Oil & Gas Projects
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TUESDAY

Continental Breakfast - Ballroom Foyer
Introduction/Welcome - Ballroom A

Regulation Discussion - 45Q

« Sarah Forbes, Office of Strategic Planning and Global
Engagement

CCUS Federal Financing Mechanisms

e Chris McLean, Assistant Administrator - Electric at the
Rural Utilities Service, USDA

e Khalid Abedin, U.S. Department of Energy Loan
Guarantee Program

Stakeholder Perspectives - The Future of CCUS

» Shannon Angielski, Executive Director, Carbon
Utilization Research Council

* Mark Coalmer, CCUS Projects Director, Oil and Gas
Climate Initiative, Climate Investiments LLP

o Kurt Waltzer, Managing Director, Clean Air Task Force
« Hilary Moffett, Occidental Petroleum Corporation

Break - Ballroom Foyer




TUESDAY

ROOM 406

CAPTURE - LAB/BENCH-SCALE RESEARCH

Moderator: David Lang, NETL

10:45 AM Advancing Post-Combustion CO, Capture Through Increased Mass Transfer (FE0031661)
» Jesse Thompson, University of Kentucky Center for Applied Energy Research

11:05 AM Molecular Refinement of Transformational Solvents for CO, Separations (FWP-72396)
o Charles Freeman, PNNL

11:25 AM Inexpensive and Sustainable Anti-Corrosion Coating for Power Generation Applications (FE0031659)
 John Watkins, Lumishield Technologies Incorporated

11:45 AM Membrane Development for Post-Combustion Carbon Capture
o David Hopkinson, NETL

12:05 PM Physical Solvent Development for Pre-Combustion Carbon Capture
» Nicholas Siefert, NETL

12:25 PM Discovery of New Materials for Carbon Capture by Computational Screening
 Jan Steckel, NETL

12:45 PM Lunch - Ballroom A

Moderator: Katharina Daniels, NETL

1:30 PM Novel CO,-Selective Membranes for CO, Capture From Less Than 1% CO, Sources (FE0026919)
» Yang Han and Winston Ho, The Ohio State University

1:50 PM Zeolite Membrane Reactor for Pre-Combustion Carbon Dioxide Capture (FE0026435)
 Lie Meng, Arizona State University

2:10 PM Transformational Membranes for Pre-Combustion Carbon Capture (FEO031635)
» Yang Han and Winston Ho, The Ohio State University

2:30 PM Bench-Scale Development of a Transformative Membrane Process for Pre-Combustion CO, Capture
(FE0031632)
« Jay Kniep, Membrane Technology and Research Inc.

2:50 PM Development of Pre-Combustion CO, Capture Process Using High-Temperature PBI (FE0031633)
* Indira Jayaweera and Elisabeth Perea, SRI International

3:10PM A High-Efficiency, Ultra-Compact Process for Pre-Combustion CO, Capture (FE0026423/FE0031737)
» Theodore Tsotsis, University of Southern California

3:30 PM Break - Ballroom Foyer



10:45 AM

11:15AM

11:45AM

12:15PM

12:45 PM

1:30 PM

2:00 PM

2:30 PM

3:00 PM

3:30 PM

TUESDAY
SUBSURFACE PLENARY

BALLROOM B

Moderator: Mary Sullivan, NETL

Tuscaloosa Marine Shale Laboratory (FE0031575)
« Mehdi Mokhtari, University of Louisiana at Lafayette

Marcellus Shale Energy and Environment Laboratory (FE0024297)
o Timothy Carr, West Virginia University

Southeast Regional Carbon Sequestration Partnership (Cranfield) - Phase IIl (FC26-05NT42590)
» Sue Hovorka, University of Texas at Austin

Southeast Regional Carbon Sequestration Partnership (Citronelle) - Phase Ill (FC26-05NT42590)
¢ Anne Oudinot, Advanced Resources International

Lunch - Ballroom A

Moderator: Mary Sullivan, NETL

Establishing an Early Carbon Dioxide Storage Complex in Kemper County, Mississippi: Project ECO,S
(FEO0029465)
» Dave Riestenberg, Advanced Resources International

Phase Il Field Demonstration at Plant Smith Generating Station: Assessment of Opportunities for Optimal
Reservoir Pressure Control, Plume Management and Produced Water Strategies (DE-FE0026140)
o Robert Trautz, Electric Power Research Institute Inc.

Offshore Gulf of Mexico Partnership for Carbon Storage - Resources and Technology Development
(FEO031558)
» Susan Hovorka, Gulf Coast Carbon Center, Bureau of Economic Geology, JSG, University of Texas at
Austin

Southeast Regional Carbon Storage Partnership: Offshore Gulf of Mexico (FEO031557)
¢ Michael Godec, Advanced Resources International

Break - Ballroom Foyer

QOil & Gas Projects
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CAPTURE AND UTILIZATION SESSION

TUESDAY

4:00 PM

4:20 PM

4:40 PM

5:00 PM

5:20 PM

6:00 PM

ROOM 406

CAPTURE - LAB/BENCH-SCALE RESEARCH

Moderator: Sai Gollakota, NETL

High-Temperature Ceramic-Carbonate Dual-Phase Membrane Reactor for Pre-Combustion Carbon
Dioxide Capture (FE0031634)
o Oscar Ovalle-Encinia, Arizona State University

Sorption-Enhanced Mixed Matrix Membranes for Hydrogen Purification and Carbon Dioxide Capture
(FE0026463)
» Haiging Lin, University at Buffalo, SUNY

CARBON CAPTURE SIMULATION FOR INDUSTRY IMPACT (CCSI?)

Moderator: Sai Gollakota, NETL

Maximizing Learning Through Intelligent Test Design
e Brenda Ng, LLNL

Application of Sequential Design of Experiments (SDoE) to Solvent-Based CO, Capture Systems at
Multiple Scales
 Joshua Morgan, NETL

Adjourn Capture and Utilization Session

End of Day



4:00 PM

4:20 PM

4:40 PM

5:00 PM

5:20 PM

5:40 PM

6:00 PM

7:30 PM

TUESDAY

SUBSURFACE BREAKOUT

Moderator: Kyle Smith, NETL
Rooms 303, 304, 305

Charged Wellbore Casing Controlled Source
Electromagnetics for Reservoir Imaging and
Monitoring (FE0028320)

* Yaoguo Li, Colorado School of Mines

New Imaging and CO, Storage Technologies for
Unconventional Subsurface Reservoirs
(FWP-70066)

e Quin Miller, PNNL

Integration of Seismic-Pressure-Petrophysics
Inversion of Continuous Active-Seismic
Monitoring Data for Monitoring and Quantifying
CO, Plume (FE0031544)

» Tieyuan Zhu, Pennsylvania State University

Joint Inversion of Time-Lapse Seismic Data
(FEO031540)
o César Barajas-Olalde, University of North
Dakota Energy and Environment Research
Center

Robust Carbon Dioxide Imaging Using Joint

Tomographic Inversion of Seismic Onset Time

and Distributed Pressure and Temperature

Measurements (FE0031625)

e Akhil Dattagupta, Texas A&M Engineering
Experiment Station

Geochemical Impacts and Signals of CO, in
Groundwater
o Christina Lopano and Ale Hakala, NETL

NRAP Tool Users Meeting - Rooms 303, 304, 305

End of Day

Moderator: Steve Henry, NETL
Rooms 301, 302

Passive Acoustic Metamaterial Proppants for
Advanced Hydraulic Fracture Diagnostics
(SC0017738)

¢ Jacob Pollock, Oceanit Laboratories Inc.

Development and Field Testing Novel Natural
Gas Surface Process Equipment for Replacement
of Water as Primary Hydraulic Fracturing Fluid
(FE0024314)

« Griffin Beck, Southwest Research Institute

A New Framework for Microscopic- to Reservoir-
Scale Simulation of Hydraulic Fracturing and
Production: Testing with Comprehensive Data
From HFTS and Other Hydraulic Fracturing Field
Test Sites (FWP-100480/FWP-FEW0250/FWP-
FP0O0008049)

¢ Jens Birkholzer, LBNL; Joe Morris, LLNL

Enhancing Unconventional Reservoir Ultimate
Recoveries with In-Situ Nano-Catalysts
(TCF-18-15390)

« Randall Winans, Argonne National Laboratory

Injection and Tracking of Micro Seismic Emitters
to Optimize Unconventional Oil and Gas
Development (FE0024360)

* Bjorn Paulsson, Paulsson Inc.

Development of a Low-Noise Optical Interrogator
for Interferometric Sensing Technologies
(SC0017729)

e Michael T.V. Wylie, Paulsson Inc.

Development of a Distributed Optical Sensor
Array for Improved Subsurface Characterization
and Monitoring (SC0017222)

¢ Michael T.V. Wylie, Paulsson Inc.

QOil & Gas Projects
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WEDNESDAY
CAPTURE AND UTILIZATION SESSION

ROOM 406

DOCCSS WITH CCSI? SUPPORT

Moderator: Andy Aurelio, NETL

8:00 AM High-Efficiency, Integrated Reactors for Sorbents, Solvents and Membranes using Additive Manufacturing
(FWP-FEW0225)
» Joshuah Stolaroff, LLNL

8:20 AM Novel Geometry Design for Intensified CO, Absorbers
» Grigorios Panagakos, Carnegie Mellon University

8:40 AM Low-Viscosity, Water-Lean CO,-Binding Organic Liquids (COZBOL) with Polarity Swing-Assisted
Regeneration (PSAR) (FWP-70924)
 Richard F. Zheng, PNNL

9:00 AM Low Aqueous Solvent System Optimization
« Zhijie Xu, PNNL

9:20 AM Amine-Appended Metal-Organic Frameworks as Switch-Like Adsorbents for Energy-Efficient Carbon
Capture (FWP-FP00006194)
« Jeffrey Long, LBNL

9:40 AM Contactor Design for Transformational Sorbents
» Debangsu Bhattacharyya, West Virginia University

10:00 AM Break - Ballroom Foyer

CAPTURE - LAB/BENCH-SCALE RESEARCH WITH CCSI? SUPPORT

Moderator: Timothy Fout, NETL

10:30 AM Additively Manufactured Intensified Device for Enhanced Carbon Capture (FWP-FEAA130)
 Xin Sun, Oak Ridge National Laboratory (ORNL)

10:50 AM Computational Design of Intercooled Packing for CO, Absorbers
 Grigorios Panagakos, Carnegie Mellon University

CAPTURE - SYSTEMS STUDIES AND MODELING

Moderator: Timothy Fout, NETL

11:10 AM Cost and Performance Baseline for Fossil Energy Plants, Volume 1: Bituminous Coal and Natural Gas to
Electricity , Revision 4
o Alexander Zoelle, NETL

11:30 AM Modeling Deployment of CCUS
o Christopher Nichols, NETL



WEDNESDAY
SUBSURFACE PLENARY

BALLROOM B

Moderator: Gary Covatch, NETL

8:00 AM Hydraulic Fracturing Test Site |, Midland Basin, West Texas (FE0024292)
« Jordan Ciezobka, Gas Technology Institute

8:30 AM Eagle Ford Shale Laboratory South Texas (FEO031579)
e A. Dan Hill, Texas A&M University

9:00 AM Hydraulic Fracturing Test Site Il, Delaware Basin, West Texas (FE0031577)
» Jordan Ciezobka, Gas Technology Institute

9:30 AM Southwest Regional Partnership Phase 3: Transition to Post-Injection
Monitoring of CCUS in an Active Qil Field (FC26-05NT42591)
e Brian McPherson, Southwest Regional Partnership on Carbon Sequestration

10:00 AM Break - Ballroom Foyer

Moderator: Andrea McNemar, NETL

10:30 AM Midwest Regional Carbon Sequestration Partnership (FC26-05NT42589)
» Neeraj Gupta, Battelle Memorial Institute

11:00 AM Midwest Geological Sequestration Consortium Update (FC26-05NT42588)
« Sallie Greenberg, University of Illinois

11:30 AM Wabash CarbonSAFE (FE0031626)
« Christopher Korose, University of lllinois at Urbana-Champaign

12:00 PM CarbonSAFE Macon County lllinois (FE0029381)
» Steve Whittaker, lllinois State Geological Survey

12:30 PM Lunch - Ballroom A

Oil & Gas Projects
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WEDNESDAY

11:50 AM

12:10 PM

12:30 PM

1:30 PM

1:50 PM

2:10 PM

2:30 PM

3:00 PM

ROOM 406

CAPTURE - PILOT-SCALE RESEARCH

Moderator: Timothy Fout, NETL

Advanced Carbon Capture Testing at the National Carbon Capture Center (FE0022596)
» Michele Corser, Southern Company

Pilot Test of a Nanoporous, Super-Hydrophobic Membrane Contactor Process for Post-Combustion
Carbon Dioxide Capture (FE0012829)
 Shiguang Li, Gas Technology Institute

Lunch - Ballroom A

Moderator: Naomi O'Neil, NETL

Pilot-Scale Slipstream Testing of Sorbent-Based CO, Capture Process (FE0012870)
e Jeannine Elliott, TDA Research Inc.

Pilot Testing of a Highly Effective Pre-Combustion Sorbent-Based Carbon Capture System (FEO013105)
» Gokhan Alptekin, TDA Research Inc.

Application of a Heat-Integrated Post-Combustion Carbon Dioxide Capture System with Hitachi
Advanced Solvent into Existing Coal-Fired Power Plant (FEO007395)
» Heather Nikolic, University of Kentucky Center for Applied Energy Research

Engineering-Scale Demonstration of the Mixed-Salt Process for CO, (FE0031588)
« Indira Jayaweera, SRI International

Break - Ballroom Foyer



1:30 PM

1:50 PM

2:10PM

2:30 PM

3:00 PM

WEDNESDAY
SUBSURFACE BREAKOUT

Moderator: Jerry Carr, NETL
Rooms 303, 304, 305

Active Seismic Monitoring of CO, Leakage
Through a Hydromechanically Reactivated Fault
Caprock Integrity Monitoring for a Geological
Carbon Sequestration Site Analog: Validating a
CASSM Monitoring System (FWP-FP00007630)
 Jens Birkholzer and Yves Guglielmi, LBNL

RIC Task 25: Long-Period, Long-Duration (LPLD)
Seismic Events Observed at Two CO, EOR
Locations

e Rick Hammack, NETL

National Risk Assessment Partnership: Strategic
Monitoring for Uncertainty Reduction
 Erika Gasperikova, LBNL

Monitoring of Geological CO, Sequestration Using
Isotopes and PF Tracers (FWP-FEAAQ45)
 Joachim Moortgat, ORNL

Break - Ballroom Foyer

Moderator: Bill Fincham, NETL
Rooms 301, 302

Offshore High Resolution 3D Seismic Data Over
the Active CO, Injection Site at Tomakomai, Japan
(FE0028193)

o Tip Meckel, University of Texas at Austin

Hexagonal Boron Nitrate-Reinforced
Multifunctional Well Cement for Extreme
Conditions (FEO031574)

¢ Rouzbeh Shahsavari, C-Crete Technologies Inc.

In-Situ Applied Coatings for Mitigating Gas
Hydrate Deposition in Deepwater (FEO031578)
e Carolyn Koh, Colorado School of Mines

An Ounce of Prevention is Worth a Pound of
Response, NETL's Big Data Technologies for
Offshore Spill Prevention

o Kelly Rose, NETL

QOil & Gas Projects
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WEDNESDAY

3:15PM

3:45 PM

4:15PM

4:45 PM

5:00 PM

6:30 PM

ROOM 406

CAPTURE - PILOT-SCALE RESEARCH

Moderator: Andrew O'Palko, NETL

Scale-Up and Testing of Advanced Polaris Membrane CO, Capture Technology (FE0031591)
o Tim Merkel, Membrane Technology and Research Inc.

Engineering Scale Testing of Transformational Non-Aqueous Solvent-Based Carbon Dioxide Capture
Process at Technology Centre Mongstad (FE0031590)
e Marty Lail, Research Triangle Institute

Membrane-Sorbent Hybrid System for Post-Combustion Carbon Capture (FEO031603)
» Gokhan Alptekin, TDA Research Inc.
End of Presentations

Poster Session - Ballroom Foyer

End of Day



3:30 PM

3:50 PM

4:10 PM

4:30 PM

5:00 PM

6:30 PM

WEDNESDAY
SUBSURFACE BREAKOUT

Moderator: Mary Underwood, NETL
Rooms 303, 304, 305

National Risk Assessment Partnership Task 2:
Containment Assurance
e Dylan Harp, LANL

Task 4: Active Reservoir Management (FEW-0191)
e Thomas Buscheck, LLNL

National Risk Assessment Partnership Task

5: Application of Risk Assessment Tools and

Methodologies to Synthetic and Field Data
e Diana Bacon, PNNL

Development of Defensible CO, Storage Methods
and Tools to Quantify Prospective Storage in the
Subsurface

e Angela Goodman and Kelly Rose, NETL

Poster Session - Ballroom Foyer

End of Day

Moderator: Bill O'Dowd, NETL
Rooms 301, 302

Northern Gulf of Mexico Offshore CO, Storage
Assessment: Final Results (FE0026083)
» Tip Meckel, University of Texas at Austin

Mid-Atlantic U.S. Offshore Carbon Storage
Resource Assessment Project (FE0026087)
» Neeraj Gupta, Battelle Memorial Institute

Southeast Offshore Storage Resource Assessment
(FE0026086)

» James Knapp and Jack Pashin, Oklahoma State
University

Corrosion-Resistant Aluminum Components
for Improved Cost and Performance of Ultra-
Deepwater Offshore Qil Production
(FWP-072971)

¢ Glenn Grant, PNNL

25






THURSDAY

Continental Breakfast - Ballroom Foyer

International CCS Value Chain Developments Panel - Ballroom A

Chair and Global Context
e Tim Dixon, General Manager, IEAGHG

Norway’s Full-Scale Integrated Project - Capture Aspects
* Bjgrn-Erik Haugan, Gassnova

Norway’s Full-Scale Integrated Project - Transport and Storage
Aspects
« Philip Ringrose, Equinor

Hydrogen Energy Supply from Australia to Japan
 Katsuya Ishikawa, KHI

Valuing CCS Flexibility on the Electricity Grid
» Geoff Bongers, Gamma Energy Technology, Australia

The Value of CCS - Socio-Economic Impacts
* Piera Patrizio, International Institute for Applied Systems
Analysis

Break - Ballroom Foyer
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THURSDAY

10:00 AM

10:30 AM

11:00 AM

11:30 AM

12:00 PM

1:00 PM

1:20 PM

1:40 PM

ROOM 406

CAPTURE - PILOT-SCALE RESEARCH

Moderator: David Lang, NETL

Advanced Solvent Testing and Evaluation at TCM (FWP-708140)
o Satish Reddy, Fluor

CAPTURE - ENGINEERING DESIGN

Moderator: David Lang, NETL

Initial Engineering Design of a Post-Combustion CO, Capture System for Duke Energy’s East Bend
Station Using Membrane-Based Technology (FEO031589)
e Desmond Dillon, Electric Power Research Institute Inc.

ION Engineering Commercial Carbon Capture Design and Costing (C3DC) (FE0031595)
o Andrew Awtry, ION Engineering LLC

Initial Engineering, Testing and Design of a Commercial-Scale, Post-Combustion CO, Capture System on
an Existing Coal-Fired Generating Unit (FE0031602)
 Jason Laumb, University of North Dakota Energy and Environmental Research Center

Lunch - Ballroom A

Moderator: Andrew Jones, NETL

Large Pilot Testing of the MTR Membrane Post-Combustion CO, Capture Process (FE0031587)
 Richard Baker, Membrane Technology and Research Inc.

UKY-CAER Heat-Integrated Transformative CO, Capture Process in Pulverized Coal Power Plants
(FEO031583)
o Kunlei Liu, University of Kentucky Center for Applied Energy Research

Large Pilot Testing of Linde-BASF Advanced Post-Combustion Carbon Dioxide Capture Technology at a
Coal-Fired Power Plant (FE0031581)
» Kevin O'Brien, University of Illinois at Urbana-Champaign



10:00 AM

10:20 AM

10:40 AM

11:00 AM

11:20AM

11:40 AM

12:00 PM

THURSDAY

SUBSURFACE BREAKOUT

Moderator: Kylee Underwood, NETL
Rooms 303, 304, 305

Refining Principal Stress Measurements in
Reservoir Underburden in Regions of Induced
Seismicity Through Seismological Tools,
Laboratory Experiments and Theory (FE0031687)
e Laura Chiaramonte, Electric Power Reseach
Institute

Identification of Faults Susceptible to Induced
Seismicity (FE0031685)
« Scott Frailey, lllinois State Geological Survey

A Non-Invasive Approach for Mapping Stress in
Subsurface Geologic Formations Considered for
CO, Sequestration (FE0031686)

o Mark Kelley, Battelle Memorial Institute

Improving Subsurface Stress Characterization for
Carbon Dioxide Storage Projects by Incorporating
Machine Learning Techniques (FE0031684)
» Robert Will, New Mexico Institute of Mining &
Technology

Development of Thermal Breakout Technology for
Determining In-Situ Stress (FE0031688)
» Jay Nopola, RESPEC

Task 5: U.S.-Japan Collaboration on Fiber Optic
Technology (FWP-ESD14095)
e Pierre Jean, LBNL

Lunch - Ballroom A

Moderator: Rob Vagnetti, NETL
Rooms 301, 302

Reactive Flow Through Experiments - A Look at
Foamed Cement and CO, Resistant Cements
e Barbara Kutchko, NETL

Methods to Enhance Wellbore Cement Integrity
with Microbially Induced Calcite Precipitation
(FE0024296)

e Adrienne Phillips, Montana State University

Nanoparticle Injection Technology for
Remediating Leaks of CO, Storage Formation
(FE0026514)

» Mija Hubler, University of Colorado

Improving Wellbore Integrity and Diagnostics-
Scanite for Well Integrity (SC0018836)
¢ Jacob Pollock, Oceanit Laboratories Inc.

Wellbore Leakage Mitigation Using Advanced
Mineral Precipitation Strategies (FE0026513)
e Adrienne Phillips, Montana State University

Programmable Sealant-Loaded Mesoporous
Nanoparticles for Gas/Liquid Leakage Mitigation
(FE0026511)

* Rouzbeh Shahsavari, C-Crete Technologies Inc.

Oil & Gas Projects

29



30

THURSDAY

2:00 PM

2:05PM

2:10PM

2:15PM

2:20 PM

2:25PM

2:30 PM

2:35PM

2:40 PM

2:45 PM

2:50 PM

2:55PM

3:00 PM

ROOM 406

CAPTURE - NEW RESEARCH PROJECTS LIGHTNING ROUND

Moderator: Andrew Jones, NETL

Validation of Transformational CO, Capture Solvent Technology with Revolutionary Stability (FE0031727)
e Erik Meuleman, ION Engineering LLC

Fog+Froth-Based Post-Combustion CO, Capture in Fossil-Fuel Power Plants (FE0031733)
» Heather Nikolic, University of Kentucky Center for Applied Energy Research

Transformational Sorbent-Based Process for a Substantial Reduction in the Cost of CO, Capture
(FEO031722)
» Ravi Jain, InnoSepra LLC

Novel Next-Generation Sorbent System for Post-Combustion CO, Capture (FE0031734)
» Gokhan Alptekin, TDA Research Inc.

Advanced Structured Adsorbent Architectures for Transformative CO, Capture Performance
(FEO031732)
+ Deborah Jelen, Electricore Inc.

Transformational Molecular Layer Deposition Tailor-Made Size-Sieving Sorbents for Post-Combustion
CO, Capture (FE0031730)
» Miao Yu, Rensselaer Polytechnic Institute

Novel Transformational Membranes and Process for CO, Capture from Flue Gas (FE0031731)
e Yang Han and Winston Ho, The Ohio State University

Rational Development of Novel Metal-Organic Polyhedra-Based Membranes for CO, Capture
(FEO031736)
» Haiging Lin, University at Buffalo, SUNY

COz UTILIZATION - NEW RESEARCH PROJECTS LIGHTNING ROUND

Moderator: Amishi Kumar, FE HQ

Unique Nanotechnology Converts Carbon Dioxide to Valuable Products (FE0031707)
e Bingyun Li and Trina Karolchik Wafle, West Virginia University

Novel Modular Electrocatalytic Processing for Simultaneous Conversion of Carbon Dioxide and Wet
Shale Gas Into Valuable Products (FEO031709)
 Jason Trembly, Ohio University

An Intensified Electro-Catalytic Process for Production of Formic Acid (FE0031720)
» Jesse Thompson, University of Kentucky Center for Applied Energy Research

CO, and Renewable Electricity into Chemicals: Formic Acid Production from Coal Flue Gas (FEO031706)
» Hongzhou Yang, Dioxide Materials Inc.

Break - Ballroom Foyer



1:00 PM

1:20 PM

1:40 PM

2:00 PM

2:20 PM

2:40 PM

3:00 PM

THURSDAY

SUBSURFACE BREAKOUT

Moderator: Josh Hull, NETL
Rooms 303, 304, 305

National Risk Assessment Partnership Task 3:
Induced Seismicity Risk
» Joshua White, LLNL

Task 4: Monitoring for Faults at a Critical State of
Stress (FWP-FE-890-18-Y18)
e Ting Chen, LANL

Poroelastic Sustainability of Pressure-Driven
Fracture in Carbon Storage Reservoir and its
Implication for Injectivity and Caprock Integrity
(FEW-0191)

e Pengcheng Fu, LLNL

Robust In-Situ Strain Measurements to Monitor
Carbon Dioxide Storage (FE0028292)
e Larry Murdoch, Clemson University

Moderator: Josh Hull, NETL
Rooms 303, 304, 305

Optimizing CO, Sweep Based on Geochemical
and Reservoir Characterization of the Residual Oil
Zone of Hess Seminole Unit (FE0024375)

* Bo Ren, University of Texas at Austin

Stacked Greenfield and Brownfield ROZ Fairways
in the lllinois Basin Geo-Laboratory: Co-
Optimization of EOR and Associated CO, Storage
(FEO031700)
» Nathan Webb, lllinois State Geological Survey;
University of Illinois

Break - Ballroom Foyer

Moderator: Kyle Smith, NETL
Rooms 301, 302

Well Integrity Atlas: Review of CO, Storage
Projects and Research Needs (FEW-0191)
e Susan Carroll, LLNL

Autonomous Monitoring of Wellbore Integrity
Applying Time Reverse Nonlinear Elastic Wave
Spectroscopy (TR NEWS) and Fiber Optic Sensing
and Communication (FWP-FE-853-17-FY17)

e Paul Johnson and Carly Donahue, LANL

Embedded Sensor Technology Suite for Wellbore
Integrity Monitoring (FWP-1022435)
e Paul Ohodnicki, NETL

Experimental Validation of Self-Sealing of
Wellbore Cement
(FWP-FE-890-18-FY18)

« Bill Carey, LANL

High-Resolution 3D Acoustic Borehole Integrity
Monitoring System (FWP-FE-855-17-FY17)
e Cristian Pantea, LANL

Well Integrity for Unconventional Reservoirs
(FWP-1022415)
e Barbara Kutchko, NETL

QOil & Gas Projects
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THURSDAY

3:30 PM

3:35PM

3:40 PM

3:45PM

3:50 PM

3:55 PM

4:00 PM

4:05 PM

4:10 PM

4:15 PM

4:20 PM

ROOM 406

CO> UTILIZATION - NEW RESEARCH PROJECTS LIGHTNING ROUND

Moderator: Amishi Kumar, FE HQ

Selective and Efficient Electrochemical Production of Neat Formic Acid from Carbon Dioxide Using Novel
Platinum Group Metals-Free Catalysts (FEO031704)
» Syed Mubeen Jawahar Hussaini, The University of lowa

CO, to Fuels Through Novel Electrochemical Catalysis (FE0031716)
e Zehua Pan, Colorado School of Mines

Design of Transition-Metal/Zeolite Catalysts for Direct Conversion of Coal-Derived Carbon Dioxide to
Aromatics (FEO031719)
 Chris Jones, Georgia Institute of Technology

Electrochemical Conversion of CO, from Coal into Fuels and Chemicals Using a Modified Pem
Electrolyzer (FEO031712)
o Etosha Cave, Opus 12 Inc.

Novel Process for CO, Conversion to Fuel (FE0031714)
» Gokhan Alptekin, TDA Research Inc.

Sustainable Conversion of Carbon Dioxide and Shale Gas to Green Acetic Acid Via a Thermochemical
Cyclic Redox Scheme (FE0031703)
» Fanxing Li, North Carolina State University

Synthetic Calcium Carbonate Production by Carbon Dioxide Mineralization of Industrial Waste Brines
(FEO031705)
» Bu Wang, University of Wisconsin - Madison

A Scalable Process for Upcycling Carbon Dioxide and Coal Combustion Residues Into Construction
Products (FE0031718)
o Gabriel Falzone, University of California - Los Angeles

Field-Scale Testing of the Thermocatalytic Ethylene Production Process Using Ethane and Actual Coal-
Fired Flue Gas CO, (FE0031713)
o Amit Goyal, Southern Research Institute

Beneficial Use of CO, from Coal-Fired Power Plants for Production of Animal Feeds (FE0031717)
» Tryg Lundquist, MicroBio Engineering

Novel Algae Technology to Utilize CO, for Value-Added Products (FEO031710)
» Fred Harrington, Helios-NRG LLC



3:30 PM

3:50 PM

4:10 PM

4:30 PM

4:50 PM

5:10 PM

5:30 PM

THURSDAY

SUBSURFACE BREAKOUT

Moderator: Bill Aljoe, NETL
Rooms 303, 304, 305

Developing CO,-EOR and Associated Storage
Within the Residual Qil Zone Fairways of the
Powder River Basin, Wyoming
» Steven Carpenter, University of Wyoming
Enhanced Oil Recovery Institute

Williston Basin-Associated CO, Storage Field
Laboratory (FE0031694)
 Steven A. Smith, University of North Dakota
Energy and Environmental Research Center

Task 3: Storage and Trapping of CO, in Multiphase
Systems (FWP-FE-890-18-FY18)
» Rajesh Pawar, LANL

Task 2: PFT Analysis Using Capillary Absorption
Tubes-Hydrocarbon-Rich Matrix (FWP-FEAA045)
e David Graham, ORNL

Moderator: Bill Aljoe, NETL
Rooms 303, 304, 305

Development of a Framework for Data

Integration, Assimilation and Learning for

Geological Carbon Sequestration (FE0026515)
o Alexander Sun, University of Texas at Austin

Intelligent Monitoring Systems and Advanced Well
Integrity and Mitigation (FE0026517)
« Julia Correa, LBNL

End of Day

Moderator: Joe Renk, NETL
Rooms 301, 302

Remote Methane Sensor for Emissions from
Pipelines and Compressor Stations Using Chirped-
Laser Dispersion Spectroscopy (FE0029059)

e Mark Zondlo, Princeton University

Novel Seal Design for Effective Mitigation
of Methane Emissions from Reciprocating
Compressors (FE0029021)

o Tim Allison, Southwest Research Institute

Emission Inventories from Natural Gas Storage

Facilities Using Regional Frequency Comb Laser

Monitoring and Aircraft Flyovers (FE0029168)
* Greg Rieker, University of Colorado

Smart Methane Emission Detection System
Development (FE0029020)
« Heath Spidle, Southwest Research Institute

In-Situ Pipeline Coatings for Methane Emissions
Mitigation and Quantification from Natural Gas
Infrastructure (FE0029069)

« Matthew Nakatsuka, Oceanit Laboratories Inc.

Sensor-Enabled Coatings for Methane Release
Mitigation (FE0029062)
e Cynthia Kutchko, PPG Industries Inc.

Oil & Gas Projects
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THURSDAY

4:25 PM

4:45 PM

5:05 PM

5:25 PM

5:50 PM

ROOM 406

CO> UTILIZATION

Moderator: Amishi Kumar, FE HQ

Microwave-Assisted Thermal Conversion of CO, and Methane Over Conductive Metal Oxides
» Douglas Kauffman, NETL

Electrode-Driven Microbial CO, Utilization
e Djuna Gulliver, NETL

Upcycled CO,-Negative Concrete for Construction Functions (FE0029825)
e Gaurav Sant, University of California - Los Angeles

Adjourn Capture and Utilization Session

End of Day









FRIDAY

Continental Breakfast - Ballroom Foyer
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FRIDAY

8:00 AM

8:20AM

8:40 AM

9:00 AM

9:20 AM

9:40 AM

10:00 AM

10:20 AM

10:30 AM

ROOM 406

CO> UTILIZATION

Moderator: Andy Aurelio, NETL

CO, Mineralization Using Porous Carbon and Industrial Wastes to Make Multifunctional Concrete
(FEO030716)
» Rouzbeh Shahsavari, C-Crete Technologies LLC

Beneficial Reuse of Carbon Emissions from Coal-Fired Power Plants Using Microalgae (FE0029623)
o Mark Crocker, University of Kentucky

A New Process for Carbon Dioxide Conversion to Fuel (FE0029866)
» Gokhan Alptekin, TDA Research Inc.

Nano Engineered Catalyst Supported on Ceramic Hollow Fibers for the Utilization of CO, in Dry
Reforming to Produce Syngas (FE0029760)
« Shiguang Li, Gas Technology Institute

Storing CO, in Built Infrastructure: CO, Carbonation of Precast Concrete Products (FEO030684)
» Brian Robert Ellis, University of Michigan

Electrochemical Conversion of Carbon Dioxide to Alcohols (FE0029868)
» Feng Jiao, University of Delaware

CO> UTILIZATION - SYSTEMS STUDIES AND MODELING

Moderator: Andy Aurelio, NETL

Overview of Carbon Utilization Analysis at NETL
» Gregory Hackett, NETL

Conclude session

Break - Ballroom Foyer



8:00 AM

8:30 AM

9:00 AM

9:20 AM

9:40 AM

10:00 AM

10:30 AM

12:00 PM

FRIDAY
SUBSURFACE WORKSHOP

ROOMS 303, 304, 305

Moderator: Rick Baker

Alaska Natural Gas Hydrate Production Testing: Test Site Selection, Characterization, and Testing
Operations
e Ray Boswell, NETL

Deepwater Methane Hydrate Characterization and Scientific Assessment in Gulf of Mexico
o Peter Flemings, University of Texas at Austin

Coupled Hydrologic, Thermodynamic, and Geomechanical Processes of Natural Gas Hydrate Production
« Mark White, PNNL

Numerical Studies for the Characterization of Recoverable Resources From Methane Hydrate Deposits
* George Moridis, LBNL

Behavior of Sediments Containing Methane Hydrate, Water, and Gas Subjected to Gradients and
Changing Conditions
o Timothy J. Kneafsey, LBNL

Natural Gas Hydrates Research NETL-RIC
e Yongkoo Seol, NETL

Break - Ballroom Foyer

End of Meeting

Oil & Gas Projects
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FRIDAY

10:45 AM

11:05 AM

11:25 AM

11:45 AM

12:05 PM

12:25 PM

12:45 PM

ROOM 406

CO> UTILIZATION

Moderator: Sai Gollakota, NETL

Low-Temperature Process Utilizing Nano-Engineered Catalyst for Olefin Production from Coal-Derived
Flue Gas (FE0029570)
 Jadid Samad, Southern Research Institute

Advanced Manufactured Carbonate Materials for Algal Biomass Production: Joint LLNL-SNL Program
(FWP-FEW0223)
 Jennifer Knipe, LLNL

Improving the Economic Viability of Biological Utilization of Coal Power Plant CO, by Improved Algae
Productivity and Integration with Wastewater Treatment (DE-FE0030822)
 Lance Schideman, University of lllinois at Urbana-Champaign; Illinois Sustainable Technology Center

Harnessing Algae Biomass to Contain Power Plant Emissions (FE0O030977)
e Wei Liao, Michigan State University

Novel Catalytic Process Technology for Utilization of CO, for Acrylonitrile Production (FEO030678)
» Marty Lail, Research Triangle Institute

High-Energy Systems for Transforming CO, to Valuable Products (FE0029787)
» Osman Akpolat, Gas Technology Institute

End of Meeting
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WEDNESDAY
POSTERS PRESENTATIONS

BALLROOM FOYER

A New Sorbent Process for Transformational Carbon Capture Process (5SC0018682)
* Gokhan Alptekin, TDA Research Inc.

High Capacity, Stable, Low Volatility Water-Lean Solvents for CO, Capture (SC0018821)
o Erik Meuleman, ION Engineering LLC

Membranes Based on Polymerized Metal-Organic Frameworks for CO, Capture (SC0018956)
« Ravi Prasad, Helios-NRG LLC

Energy-Efficient Carbon Capture Processes with Adsorbents Displaying Non-Traditional Isotherms (SC0018957)
o Carly Anderson, Mosaic Materials Inc.

Integrated Multichannel Water Gas Shift Catalytic Membrane Reactor for Pre-Combustion Carbon Capture (SC0018853)

* Zhong Tang, Bettergy Corporation

Validation of Transformational CO, Capture Solvent Technology with Revolutionary Stability (FE0031727)
o Erik Meuleman, ION Engineering LLC

Fog+Froth-Based Post-Combustion CO, Capture in Fossil-Fuel Power Plants (FE0031733)
» Heather Nikolic, University of Kentucky Center for Applied Energy Research

Transformational Sorbent-Based Process for a Substantial Reduction in the Cost of CO, Capture (FE0031722)
» Ravi Jain, InnoSepra LLC

Novel Next-Generation Sorbent System for Post-Combustion CO, Capture (FE0031734)
* Gokhan Alptekin, TDA Research Inc.

Transformative Carbon Dioxide Capture (FE0031732)
o Deborah Jelen, Electricore Inc.

Transformational Molecular Layer Deposition Tailor-Made Size-Sieving Sorbents for Post-Combustion CO, Capture
(FEO031730)
« Miao Yu, Rensselaer Polytechnic Institute

Novel Transformational Membranes and Process for CO, Capture from Flue Gas (FE0031731)
* Yang Han and Winston Ho, The Ohio State University

Rational Development of Novel Metal-Organic Polyhedra-Based Membranes for CO, Capture (FE0031736)
» Haiging Lin, University at Buffalo, SUNY

Posters Presentations



Memzyme Technology for Cost-Effective CO, Separations in Enhanced Oil Recovery (TCF-17-13314)
e Susan Rempe, Sandia National Laboratories

Carbon Capture Retrofit Tools
e Timothy Fout, NETL

Preliminary Evaluation of the Design Implications of Membrane Modules into Large Scale Post-Combustion Carbon Capture
e Timothy Fout, NETL

Update of Greenhouse Gas Reductions in the Power Industry Using Domestic Coal and Biomass with Pulverized Coal Plants
« Timothy Fout, NETL

Membrane-Integrated Sorbent Adsorption Process for Carbon Capture (5SC0011885)
¢ Gokhan Alptekin, TDA Research Inc.

CO, Separation Membranes for Hot Flue Gases (SC0017124)
¢ Matthew Merrill, Luna Innovations Inc.

High-Efficiency Post-Combustion Carbon Capture System (SC0017221)
o Codruta Loebick, Precision Combustion Inc.

Modeling of Amine Solutions Reacted With CO,
o Surya Prakash Tiwari, NETL

Development of Highly Porous Hollow Fiber Support for Post-Combustion Carbon Capture
» Shouliang Yi, NETL

Computational Efforts to Push the Limits of Current Physical Solvents for Carbon Pre-Combustion Capture
* Wei Shi, Battelle Memorial Institute/NETL

Screening of Polymers by Integration of Web Scraping, Data Mining,
Molecular Modeling and Machine Learning Studies for Carbon-Capture Application
¢ Wei Shi, Battelle Memorial Institute/NETL

Poly(1,3-dioxlane)-Based Mixed Matrix Membranes for CO,/N, Separation
o Krysta Clark, NETL and University at Buffalo, SUNY

Effect of Humidity on PIM-1-Based Membrane Transport Property and Physical Aging
e ZiTong, NETL

Structural Design of Cross-Linked Polymer and lonic Liquids for lon Gel Gas Separation Membranes
e Victor Kusuma, NETL

Solubility and Diffusivity of Syngas Components Into Novel Pre-Combustion CO, Capture Solvents
« Nicholas Siefert, David Hopkinson, Lei Hong, Robert Thompson, Wei Shi and Kevin Resnik, NETL

Posters Presentations
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Enhanced CO, Capture Through Process Intensification
» Costas Tsouris, ORNL

Integration of Magnetohydrodynamic (MHD) Power Plant Models via the Framework for Optimization, Quantification of

Uncertainty, and Surrogates (FOQUS)
o Frits Byron Soepyan, NETL

CFD Study on the Effective Area Predictions for Different TPMS Structures
e Chao Wang, PNNL

Bench-Scale Experiment and CFD Simulations for Aqueous and Nonaqueous Solvent Systems with Different Packings

e Yucheng Fu, PNNL

The FOQUS Sequential Design of Experiments (SDoE) Module: Present and Future Capabilities
* Towfig Ahmed, LANL

CCSI Toolset: Developer and User Support Life Cycle
o Keith Beattie, LBNL

Comparing CO,BOLs Bench-Scale Data and CFD Models Using Sequential Design Experiments (SDoE)
o K. Sham Bhat and John Baca, LANL

Solar Energy-Powered Material-Based Conversion of CO, to Fuels (SC0015855)
» Jeffrey Weissman, Precision Combustion Inc.; Neal P. Sullivan, Colorado School of Mines

Novel Algae Technology for CO, Utilization (SC0017077)
» Fred Harrington, Helios-NRG LLC

Electrochemical Reduction of Carbon Dioxide to Useful Chemical Intermediates (SC0017105)
¢ Philip Cox, Mainsream Engineering Corporation

Technology Developments in Carbon Dioxide Electroreduction (5C0015173)
 Brian Skinn, Faraday Techology Inc.

Plasma-Assisted Catalysis for CO, and CH, (5C0019664)
* Howard Pearlman, Advanced Cooling Technologies Inc.

Unique Nanotechnology Converts Carbon Dioxide to Valuable Products (FE0031707)
» Bingyun Li and Trina Karolchik Wafle, West Virginia University

Novel Modular Electrocatalytic Processing for Simultaneous Conversion of Carbon Dioxide and Wet Shale Gas Into Valuable

Products (FE0031709)
e Jason Trembly, Ohio University

Posters Presentations



An Intensified Electro-Catalytic Process for Production of Formic Acid (FE0031720)
* Jesse Thompson, University of Kentucky Center for Applied Energy Research

CO, and Renewable Electricity Into Chemicals: Formic Acid Production from Coal Flue Gas (FE0031706)
» Hongzhou Yang, Dioxide Materials Inc.

Selective and Efficient Electrochemical Production of Neat Formic Acid From Carbon Dioxide Using Novel Platinum Group
Metals-Free Catalysts (FE0031704)
* Syed Mubeen Jawahar Hussaini, The University of lowa

CO, to Fuels Through Novel Electrochemical Catalysis (FE0031716)
e Zehua Pan, Colorado School of Mines

Design of Transition-Metal/Zeolite Catalysts for Direct Conversion of Coal-Derived Carbon Dioxide to Aromatics
(FE0031719)
o Chris Jones, Georgia Institute of Technology

Electrochemical Conversion of CO, from Coal into Fuels and Chemicals Using a Modified Pem Electrolyzer (FE0031712)
» Etosha Cave, Opus 12 Inc.

Novel Process for CO, Conversion to Fuel (FE0031714)
* Gokhan Alptekin, TDA Research Inc.

Sustainable Conversion of Carbon Dioxide and Shale Gas to Green Acetic Acid Via a Thermochemical Cyclic Redox Scheme
(FEO031703)
o Fanxing Li, North Carolina State University

Synthetic Calcium Carbonate Production by Carbon Dioxide Mineralization of Industrial Waste Brines (FE0031705)
* Bu Wang, University of Wisconsin - Madison

A Scalable Process for Upcycling Carbon Dioxide and Coal Combustion Residues Into Construction Products (FE0031718)
o Gabriel Falzone, University of California - Los Angeles

Field-Scale Testing of the Thermocatalytic Ethylene Production Process Using Ethane and Actual Coal-Fired Flue Gas CO,
(FEO031713)
* Amit Goyal, Southern Research Institute

Novel Algae Technology to Utilize CO, for Value-Added Products (FE0031710)
» Fred Harrington, Helios-NRG LLC

Incorporation of CO, Microsorbents Into Bioreactor Chips for Air Capture, Conversion and Purification
(TCF-18-15781)
» Congwang Ye, LLNL

Direct Electrochemical Valorization of Captured CO, (TCF-18-15716)
o Luis Diaz Aldana, Idaho National Laboratory

Posters Presentations
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Cost Analysis Associated With Capture, Transport, Utilization and Storage (CTUS) of CO,
e Tim Grant, NETL

Fundamental Reservoir Properties for High Priority Depositional Environments Targeted for CO, Storage
¢ Johnathan Moore and Dustin Crandall, NETL

Impacts of CO,-Exposed Microbial Ecology on Reservoir Performance
* Djuna Gulliver, NETL

Field Tools for Direct Monitoring of CO, and Brine Impacts in Groundwater Systems
e Paul Ohodnicki, NETL

Update on DOE FE's Virtual Subsurface Data Framework: EDX and ML/NLP Algorithms to Transform Data for Engineered-
Natural Systems
o Kelly Rose, NETL

Characterizing Shales as Seals for CO, Containment and Shales as Reservoirs for Geologic Storage of CO,
¢ Dustin Crandall and Sean Sanguinito, NETL

Embedded Sensor Technology Suite for Wellbore Integrity Monitoring
¢ Paul Ohodnicki, NETL

CO,-EOR Monitoring and Greenhouse Gas Life-Cycle Analysis-Integration of 22 Years of Field Operations Data
» Joel Sminchak, Battelle Memorial Institute

Geological Storage of CO, in Sub-Seafloor Basalt Offshore Washington State and British Columbia (CarbonSAFE Cascadia
Project)
» David Goldberg, Columbia University

Comparison of Resource Estimate Methodologies to Assess CCS Potential for the Northern Niagaran Pinnacle Reef Trend
o Autumn Haagsma, Battelle Memorial Institute

Comparison of Seismic Monitoring Technologies Across Reefs
* Mark Kelley, Battelle Memorial Institute

NRAP Tools and Workflows for Risk Assessment and Management at Geologic Carbon Storage Sites
e Burt Thomas, NETL - NRAP

Considerations for Risk-Based Determination of Post-Injection Closure Period at Geologic Carbon Storage Sites
o Chris Brown, PNNL - NRAP

Risk-Based Conformance Evaluation at Geologic Carbon Storage Sites
« Bailian Chen, LANL - NRAP

Using Modeling of Monitoring for Leak Detection Threshold Evaluation at Geologic Carbon Storage Sites
o Erika Gasperikova, LBNL - NRAP

Posters Presentations



Best Practices for Addressing Induced Seismicity Associated with Subsurface Injection
* Dennise Templeton, LLNL - NRAP

Coupled Hydro-Mechanical Modeling at Farnsworth West Unit, Ochilitree County, Texas
¢ Robert Will, New Mexico Tech - PRRC

Stress Evaluation in the Morrow Formation in the Farnsworth Field, Ochilitree, Texas
* Robert Will, New Mexico Tech - PRRC

Optimizing CO,-EOR Reservoir Management Strategy in the Chester 16 Reef Integrating Distributed Temperature Sensing
and Seismic Data
¢ Ashwin Pasumarti, Battelle Memorial Institute

Revelations in Monitoring
« Katherine Romanak, University of Texas Bureau of Economic Geology

Site Resource Assessment - High Island Blocks - GoMCarb Partnership
« Ramon Trevino, University of Texas at Austin

Clarifying the Likelihood of Subsurface Fluid/Gas Migration Using SIMPA Tool
¢ Jennifer Bauer, NETL

NATCARB Development for Enhanced Data Access, Discoverability, and Analytics
e Jennifer Bauer, NETL

The Regrid Project: Reservoir Model Grid Conversion for Different CCS Simulators
» Brian McPherson, Southwest Regional Partnership on Carbon Sequestration

Disparities in Measured Single-Phase Permeability for Same Rock, Different Fluids
e Brian McPherson, Southwest Regional Partnership on Carbon Sequestration

Mathematical Analysis of Continuous Surface Measurements for CO, and CH, Leak Detection, Location, and Quantification
« Brian McPherson, Southwest Regional Partnership on Carbon Sequestration

Impact of Hydrocarbons on Geochemical Reactions and CO, Mineralization for Carbon Sequestration Through CO,-EOR
e Brian McPherson, Southwest Regional Partnership on Carbon Sequestration

Relative Permeability Derived from Capillary Pressure
» Brian McPherson, Southwest Regional Partnership on Carbon Sequestration

Impact of Relative Permeability and Capillary Pressure on Chemical Trapping of Carbon Dioxide in the Subsurface
* Brian McPherson, Southwest Regional Partnership on Carbon Sequestration

Chemo-Mechanical Degradation in Carbonate-Cemented Sandstone Induced from Carbon Sequestration: An Experimental
Study of CO,-Brine-Rock Interation
o Zhidi Wu, Southwest Regional Partnership on Carbon Sequestration

Chemo-Mechanical Impacts of CO, Intrusion into Heterogeneous Caprock
« Brian McPherson, Southwest Regional Partnership on Carbon Sequestration
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Assessments of Onshore and Offshore CO, Storage Potential in Mid-Atlantic States
» Neeraj Gupta, Battelle Memorial Institute

Electromagnetic Geophysical Survey Design for Injection Monitoring During the BEST Project
» Michael Wilt, LBNL

Methodology & Tool for Estimating Offshore Carbon Storage Resource Potential in Saline Aquifer
» Kelly Rose, NETL

The Role of Different Combinations of Dimensionless Numbers and Surface Mineralogy Heterogeneity on Multiphase Flow

Properties
¢ Cheng Chen, Virginia Tech

Reactive Transport Modeling of Water-CO,-Oil Interactions in the Farnsworth Unit, Texas
* Martin Appold, University of Missouri

Geochemical Modeling of CO, Storage in North Dakota Formations
o Arelys Salazar, University of North Dakota Energy & Environmental Research Center

A Simulation Study of the Integrated Mid-Continent Stacked Carbon Storage Hub Project Phase Il
o Chantsalmaa Dalkhaa, University of North Dakota Energy & Environmental Research Center

North Dakota CO, Storage Feasibility Study - Numerical Simulation Efforts
o Arelys Salazar, University of North Dakota Energy & Environmental Research Center

North Dakota Brine Treatment Test Bed Facility
* Ryan Klapperich, University of North Dakota Energy & Environmental Research Center

Best Practices for CO, Geological Storage
« Neil Wildgust, University of North Dakota Energy & Environmental Research Center

Engineering Designs for Integrated Small-Scale CCS System
» Ryan Klapperich, University of North Dakota Energy & Environmental Research Center

Wallula CO, Injection Simulations
» Signe White, PNNL

Methodology & Tool for Estimating Offshore Carbon Storage Resource Potential in Saline Aquifers
e Lucy Romeo, NETL

CO, Injection Monitoring With an Optimized, Scalable Automated Semipermanent Seismic Array
» Cesar Barajas-Olalde, University of North Dakota Energy & Environmental Research Center

A Large 3C Fiber Optic Borehole Vector Seismic Receiver Array to Survey & Monitor the Subsurface
e Bjorn Paulsson and Mike Wylie, Paulsson Inc.

SimCCS?°: Next Generation of CCS Infrastructure Optimization
» Richard Middleton, LANL
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RBDMS, Fracfocus, and Produced Water Initiative (FE0027702)
* Dan yates and Mark Layne, Ground Water Protection Council Inc.

Resident Inline Robot for Leakage Inspection, Repair and Prevention of Methane Emissions (SC0018906)
» Dave Antanavige, ULC Robotics

Development of Multifunctional Distributed Fiber Sensors for Methane Leak Detection (FE0029063)
» Kevin Peng Chen, University of Pittsburgh

Modeling Fractured Shale Networks for Horizontal Well Development (SC0018816)
* Harry Johnson, Intek Inc.

Microbial Ecology of Hydraulic Shale Environments (FWP-1022415 Task 4)
* Djuna Gulliver, NETL

NFflow Reservoir Simulation for Representing Coupled P & T Effects on Fractures (FWP-1022415 Task 5)
¢ W. Neal Sams, NETL

Experimental Study of Barite Scaling in Marcellus Shale During a Simulated Injection and Shut-In Period of Hydraulic
Fracturing (FWP-1022415 Task 11)
o Christina Lopano, NETL

Digital Core Characterization (FWP-1022415 Task 2)
e Dustin Crandall, NETL

Characterizing Application of CO, as a Recovery Agent to Mobilize Hydrocarbons from Shale (FWP-1022415 Task 9)
* Angela Goodman, NETL

The Importance of Organic Matter in Shale Redox (FWP-1022415 Task 3)
¢ Brandon McAdams, NETL

NETL-RIC Onshore Unconventional Resources Portfolio (FWP-1022415)
* Alexandra Hakala, NETL

Improved Utilization of Discrete and Heterogeneous Petrophysical Data: An Example From the Tuscaloosa Marine Shale
» David Borrok, Missouri University of Science and Technology

Grid-Scale, Long-Term Energy Storage: Repurposing Hydrocarbon Reservoirs, Resources, and Infrastructure to Store CO, and
Heat
e Tom Buscheck, LLNL

Developing Biomineralization Technology for Ensuring Wellbore Integrity
* Adrienne Phillips and Lee Spangler, Montana State University

Numerical Simulations of Gas Production from Gas Hydrate Reservoirs at the Prudhoe Bay Unit 7-11-12 Pad on Alaska North
Slope
» Yongkoo Seol, Harpreet Singh, Xuerui Gai and Ray Boswell, NETL; Evgeniy Myshakin, Battelle Memorial Institute
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Comparison of Unsupervised and Supervised Machine Learning Algorithms for Automated Well-Log Processing and
Classification
» Harpreet Singh and Yongkoo Seol, NETL; Evgeniy Myshakin, Battelle Memorial Institute

Mix3-HydResSim-GM: A Fully Coupled THCM Simulator for Gas Hydrate Reservoir
e Xuerui Gai and Yongkoo Seol, NETL; Evgeniy Myshakin, Battelle Memorial Institute; Shun Uchida, Rensselaer Polytech
Institute; Jeen-Shang Lin, University of Pittsburgh

Pressure Core Characterization and X-Ray CT Visualization Tool: Bridging Between Core-Scale Behavior and Pore-Scale
Observations
o Liang Lei, Jeong-Hoon Choi, Xuerui Gai and Yongkoo Seol, NETL

Calibrating Recovery Efficiency Estimates Using Production Data: An Example from the Marcellus Formation in West Virginia
* Ray Boswell, NETL

Building Data-Driven Analytical Tools to Evaluate Offshore Infrastructure Integrity
» Jennifer Bauer and Lucy Romeo, NETL

Data-Enhanced Kick Detection: NETL's Low-Cost Monitoring and Early Detection Technology
* Kelly Rose, NETL

Characterizing Application of CO, as a Recovery Agent to Mobilize Hydrocarbons from Shale (FWP-1022415 Task 9)
* Angela Goodman, NETL

Well Cement Behavior and Gas Migration During Early Hydration - Methods to Determine Cement Slurry Gelation to Ensure
Wellbore Integrity
o Eilis Rosenbaum, NETL

Flow of a Cement Slurry Modeled as a Generalized Second Grade Fluid
e Chengcheng Tao, NETL

An Analysis of the Natural Fracture Network Surrounding the MSEEL Well and Analog Outcrop Data (FWP-1022415 Task 5)
* Mark McKoy, NETL

Posters Presentations



NOTES




THANK YOU

. DEPARTMENT OF

ENT O
5 8
)
R
2 »

FOR ATTENDING

Office of
Fossil Energy

NATIONAL
ENERGY
TECHNOLOGY
LABORATORY




